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!
!
1!
!
Beloved!student,!
!
This!brief!and!simple!style!sheet!is!designed!to!guide!you!through!the!standard!practices!of!formatting!
papers!written!at!Calvary!Chapel!Bible!College.!!The!standards!are!based!on!Kate!Turabian’s!Manual&for&
Writers,&7th&Edition!and!the!Chicago&Manual&of&Style,&17th&Edition.!!I!hope!this!guide!will!answer!and!
clarify!many!of!your!questions!and!concerns!as!you!are!faced!with!the!daunting!task!of!writing!papers!at!
the!collegiate!level.!!Simply!follow!the!steps!I!have!outlined,!and!you!are!on!your!way!to!writing!properly!
formatted!papers.!
!
May!God!richly!bless!you!as!you!grow!in!wisdom!and!knowledge.!
!
Soli!Deo!Gloria!
!
James!M.!Lee!
CCBC!Librarian!
Fall!2010!
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!
!
1.1!

Introduction 

 
When!writing!a!research!paper,!the!student!should!follow!accepted!academic!standards!for!citation,!
style,!and!format.!!Citation!is!the!act!of!carefully!and!appropriately!giving!credit!to!those!authors!who!
have!influenced!your!ideas.!!It!is!essential!that!you!accurately!and!properly!document!your!sources.!
Style!and!format!deal!with!how!that!information!is!presented!when!writing!a!paper.!There!exist!several!
styles!to!cite!sources,!but!I!will!only!present!one!approved!at!CCBC—the!Turabian!NotesKBibliography!
style.!!The!following!guide!is!meant!to!provide!you!with!basic!information!to!get!you!started.!!More!
detailed!information!can!be!obtained!by!referring!to!Turabian’s!A&Manual&for&Writers,&7th&Edition.!!We!
begin!with!a!discussion!of!the!basic!paper!format.&&!
!

1.2!

Paper Format 

When!using!Microsoft!Word,!most!of!these!settings!are!set!as!default.!!However,!the!shaded!text!offers!
some!guidance!on!how!to!change!a!setting.!
!

Paper!Type:!!8K½KbyK11Kinch!white!paper!
!
Margins:!!1Kinch!margins!on!all!sides!
!
Spacing:!DoubleKspaced,!notes,!and!bibliographic!entries.!

o Block!Quotations!of!5!or!more!lines!are!single!spaced!with!no!quotation!marks!and!
indented!1!inch.!!

!
Font:!!Times!New!Roman,!Garamond,!Georgia,!or!Calibri!
!
Font!Size:!!12Kpoint!font!size!
!
Page!Number:!!Upper!right!corner!beginning!on!second!page.!!Title!page!is!not!numbered.!
!

MSWord>Insert>Page!Numbers!
!
Title!Page:!separated!and!on!top!of!paper.!

!

!

!

!
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1.3!

Title Page 

 
This!information!should!be!set!apart!from!the!body!of!the!paper!and!placed!on!a!separate!page!in!the!
order!listed.!
!

Title!of!Paper!–!About!half!way!down!the!page,!centered,!capitalized.!
Your!Name!–!Beneath!the!title,!centered!
Course!Title!&!Number!–!centered!2!inches!from!bottom!of!title!page!
Name!of!Instructor!–!centered!below!Course!Name!
Name!of!Bible!College!–!centered!below!name!of!instructor!
Date!–!centered!below!name!of!College!
No!page!number!on!this!page,!but!it!is!considered!page!1!
All!words!capitalized!except!prepositions!(e.g.!The!Meaning!of!Grace!in!…)!!
!
Title!Page!Example:!
!

!
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2!

Footnotes and Bibliography  
!

Here!are!some!basic!questions!you!might!have!pondered:!

2.1!

When should I cite? 

1. When!using!exact!words!from!a!source.!

2. When!you!paraphrase!ideas!that!are!associated!with!the!specific!source,!even!if!you!do!not!
quote!exact!words!from!it.!

3. When!you!use!any!idea,!data,!or!method!attributable!to!any!source!you!consulted.!

2.2!

Why should I cite? 

1. When!the!words!of!others!would!present!strong!evidence!to!back!up!your!reasons!for!your!
argument.!

2. When!you!wish!to!be!fair!and!state!exactly!what!you!disagree!with.!

3. When!you!wish!to!add!an!authority!who!agrees!with!your!view.!

4. When!the!words!of!others!are!strikingly!unique,!compelling,!and!memorable.!

2.3!

What kind of information will I need to cite? 

You!can!locate!relevant!publication!information!on!the!first!and!second!pages!of!most!published!
material.!!!

1.!Who!wrote!or!assembled!the!source?!

Author!(s)!
Editor!(s)! !
Translator!(s)!

!

!
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2.!What!data!identifies!the!source?!

Title!and!subtitle!
Title!and!subtitle!of!any!larger!work!that!contains!the!source!(such!as!a!collection,!
journal,!or!newspaper)!
Page!number(s)!
Volume!number!
Issue!number!
Edition!number!
URL!and!date!you!accessed!the!material,!for!online!sources!

!

3.!Who!published!the!source!and!when?!

Publisher’s!name!
Place!of!publication!
Date!of!publication!

!

There!are!three!elements!for!every!source.!!When!you!use!a!(1)!quote!in!your!paper,!you!will!need!to!
have!a!(2)!footnote!to!represent!it,!and!also!it!will!be!listed!in!your!(3)!Bibliography.!

!

3.0!

The In-text Quote 

The!writing!of!others!should!flow!smoothly!into!your!writing.!!Sometimes!you!may!want!to!use!exact!
words!or!phrases.!!This!is!called!quoting.!!Sometimes!you!may!wish!to!weave!the!grammar!of!the!quote!
into!the!grammar!of!your!own!writing.!!In!some!cases!when!you!quote,!you!may!want!to!use!a!signal!
verb!or!phrase!to!carefully!and!smoothly!integrate!quotations!into!your!text!and!surrounding!sentences.!
Here!is!a!list!of!some!signal!words: 
!

!

!

!

!

!

!
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3.1!

Signal Verbs 

!
accepts!

acknowledges!
adds!
admits!
advises!
agrees!
allows!
answers!
argues!
asserts!
believes!
claims!
charges!

comments!
compares!
complains!
concedes!
concludes!
concurs!
confirms!
considers!
contends!

!

!
criticizes!
declares!
deduces!

demonstrates!
denies!

describes!
discusses!
disputes!
endorses!

emphasizes!
expresses!

feels!
grants!

hypothesizes!
illustrates!
implies!
insists!

interprets!
lists!
notes!
objects!
observes!

!

!
offers!

opposes!
points!out!
proves!

questions!
recommends!

reflects!
reasons!
refutes!
rejects!
replies!
remarks!
reports!
responds!
reveals!

says!states!
suggests!
suspects!
thinks!
urges!
writes!

!
!

!

3.2!

Some examples of in-text quoting!

There!are!many!ways!to!incorporate!sources!into!your!writing.!!However,!if!you!are!quoting!4!lines!or!
less,!use!quotation!marks!and!run!it!into!your!text.!!If!you!are!quoting!5!or!more!lines,!use!a!block!
quotation;!see!3.3.!!The!following!are!examples!of!inKtext!quoting!with!4!lines!or!less:!!

Q:!In!presenting!his!case!for!Christianity,!Lee!Strobel!urges!his!readers!to!“thoughtfully!
consider!the!credibility!of!the!witnesses,!carefully!sift!the!testimony,!and!rigorously!
subject!the!evidence!to!common!sense!and!logic.”1!

Use!an!author’s!full!name!the!first!time!you!mention!it,!afterwards!use!only!the!last!name:!

! Q:!In!presenting!his!case!for!Christianity,!Lee!Strobel!urges!his!readers!to!“thoughtfully!
consider!the!credibility!of!the!witnesses,!carefully!sift!the!testimony,!and!rigorously!
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subject!the!evidence!to!common!sense!and!logic.”1!In!particular,!Strobel!highly!
encourages!his!readers!to!test!the!eyewitness!evidence!for!the!historicity!of!Jesus!of!
Nazareth.2!

You!can!modify!the!original!quote!with!square!brackets!and!delete!with!three!dots!(ellipses),!as!long!as!
you!don’t!change!the!meaning!or!disturb!the!grammar:!!

! Original!quote:!

Q:!In!response!to!Blomberg’s!argument!for!the!validity!of!the!Gospels,!Strobel!says,!“His!
evidence!for!their!traditional!authorship,!his!analysis!of!the!extremely!early!date!of!
fundamental!beliefs!in!Jesus,!his!wellKreasoned!defense!of!the!accuracy!of!the!oral!
tradition,!his!thoughtful!examination!of!apparent!discrepancies!–!all!of!his!testimony!
had!established!a!solid!foundation!for!me!to!build!on.”3!

Words!modified:!

Q:!In!response!to!Blomberg’s!argument!for!the!validity!of!the!Gospels,!Strobel!
acknowledges,!“[Blomberg’s]!evidence!for![the!Gospels’]!traditional!authorship,!his!
analysis!of!the!extremely!early!date!of!fundamental!beliefs!in!Jesus,!his!wellKreasoned!
defense!of!the!accuracy!of!the!oral!tradition,!his!thoughtful!examination!of!apparent!
discrepancies!–!all!of![Blomberg’s]!testimony!had!established!a!solid!foundation!for!me!
to!build!on.”3!

Words!deleted:!

Q:!In!response!to!Blomberg’s!argument!for!the!validity!of!the!Gospels,!Strobel!
acknowledges,!“[Blomberg’s]!evidence!for![the!Gospels’]!traditional!authorship,!his!
analysis!of!the!extremely!early!date!of!fundamental!beliefs!in!Jesus,!his!wellKreasoned!
defense!of!the!accuracy!of!the!oral!tradition,!his!thoughtful!examination!of!apparent!
discrepancies!.!.!.!!had!established!a!solid!foundation!for!me!to!build!on.”3!

3.3!

Block Quotations 

If!you!quote!5!or!more!lines!of!a!single!source,!use!an!indented!block!quotation.!!A!block!quotation!
should!be!singleKspaced!and!a!line!should!be!added!before!and!after!it.!!Indent!the!entire!quotation!up!
to!the!first!line!of!a!paragraph!and!do!not!use!quotation!marks.!

!
MSWord>Highlight!Text>Format>Paragraph>AlignmentKjustified>!IndentationKleft!&!right!1”.!

!

Q:!In!discussing!faith,!Lewis!gives!a!gentle!caution!to!the!believer:!
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There!are!certain!things!in!Christianity!that!can!be!understood!from!the!outside,!before!
you!have!become!a!Christian.!!But!there!are!a!great!many!things!that!cannot!be!
understood!until!after!you!have!gone!a!certain!distance!along!the!Christian!road.!!These!
things!are!purely!practical,!though!they!do!not!look!as!though!they!were.!!They!are!
directions!for!dealing!with!particular!crossroads!and!obstacles!on!the!journey!and!they!
do!not!make!sense!until!a!man!has!reached!those!places.!1!!!

3.4!

Quoting the Bible 

Generally,!when!you!refer!to!an!entire!book!or!to!whole!chapters!from!the!Bible,!write!the!full!name!of!
the!book,!do!not!abbreviate,!italicize,!or!underline.!

Example:!!

Genesis!2K3!records!the!creation,!temptation,!and!fall!of!Man.!

While!in!prison,!Paul!penned!1st!Corinthians.!!

3.5!

Quoting a verse of the Bible 

When!you!quote!a!verse!or!verses!from!the!Bible,!use!quotation!marks.!!You!may!wish!to!refer!to!the!
author!or!to!the!Book!in!your!text.!!Sections!6.0!K!6.6!in!particular!discuss!how!and!when!to!use!a!
footnote!or!a!parenthetical!note!when!you!cite!the!Bible.!!The!examples!below!contain!both!footnote!
and!parenthetical!notes.!

Examples:!

Q:!!Both!Peter!and!Paul!unashamedly!defend!the!divine!authority!of!Scripture.!!Peter!declares!
that!“no!prophecy!of!Scripture!came!about!by!the!prophet’s!own!interpretation.!!For!prophecy!
never!had!its!origin!in!the!will!of!man,!but!men!spoke!from!God!as!they!were!carried!along!by!
the!Holy!Spirit.”1!

Q:!!In!addressing!the!Father,!Jesus!confirms!the!inerrancy!of!Scripture!when!He!says,!“Your!
Word!is!truth”!(Jn!10:35).!

!

!

!

!
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3.6!

Quoting verses of the Bible 

!

When!quoting!three!or!more!verses,!use!block!quotation!and!one!footnote.!!!

Example:!

Q:!Paul!encourages!the!Ephesians!to!“look!carefully!then!how!you!walk,!not!as!unwise!but!as!wise,!
making!the!best!use!of!the!time,!because!the!days!are!evil.!Therefore!do!not!be!foolish,!but!understand!
what!the!will!of!the!Lord!is.!!And!do!not!get!drunk!with!wine,!for!that!is!debauchery,!but!be!filled!with!
the!Spirit…”!1!

1.!!The&Holy&Bible&:&English&Standard&Version.!(Wheaton:!Standard!Bible!Society,!2001),!Eph!5:15–
18.!

When!quoting!many!verses!of!Scripture,!do!not!include!a!verse!number!for!each!verse.!See!sections!6.0K
6.6!on!how!to!cite!a!quotation!from!the!Bible!with!a!long,!short,!or!parenthetical!note.!

!

4.0!

The Footnote 

!

Whenever!you!use!an!outside!source,!you!must!write!a!note!for!that!source!in!the!form!of!a!long!or!
short!footnote.!!Notice,!some!quotes!above!use!a!superscript!number!at!the!end!of!the!sentence!to!
signal!that!you!have!used!a!source!(the!superscript!is!that!number!at!the!end!of!the!quotation!mark!or!
sentence!that!sits!slightly!above!the!rest!of!the!sentence,!e.g.!123456).!!The!superscript!informs!the!reader!
that!information!about!that!source!can!be!found!in!the!footnote!of!the!paper.!!The!footnote!
corresponds!to!the!number!of!the!superscript!and!provides!relevant!information!about!that!source!as!
well!as!a!relevant!page!number.!The!first!time!you!note!a!source,!use!a!long!footnote,!then!use!a!short!
note!or!parenthetical!note!afterwards!for!the!same!source.!!A!long!footnote!contains!full!publication!
information,!whereas!the!short!does!not.!!The!short!note!will!be!discussed!later!(see!5.0!K!5.7)!as!well!as!
the!parenthetical!note!(see!5.6,!6.6).!!

!

!

!
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4.1!

MSWord, Apple, & Logos shortcuts 

Microsoft!Word!and!other!software!programs!have!made!it!easy!to!include!a!footnote!into!your!paper.!!
At!the!end!of!your!quote,!paraphrase,!or!summary,!follow!the!procedure!to!include!a!footnote:!

PC>MSWord>Insert>Reference>Footnote!

Apple>WordMac>Insert>Footnote!

Apple>Pages>Insert>Footnote!

!

Logos!Software:!

Logos>Tools>Program!Settings>!Citation!Style>Turabian!

Logos>Tools>Program!Settings>Copy!Citations>Yes!

Logos>Tools>Program!Settings>Copy!Footnotes>No!

4.2!

Here!are!the!patterns!and!some!examples!of!how!to!make!a!long!footnote:!

!

Long Note - Single Author 

N:!!Note!Number.!!Author’s!First!Name!and!Last!Name,!Title&of&Book:&Subtitle&of&Book!(Place!of!
Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

1.!Lee!Strobel,!The&Case&For&Christ:&A&Journalist’s&Personal&Investigation&of&the&Evidence&for&Jesus&
(Grand!Rapids,!Michigan:!Zondervan,!1998),!18.!

4.3!

Long Note -Two Authors 

N:!!Note!Number.!!1st!Author!First!Name!and!Last!Name!and!2nd!Author!First!Name!and!Last!Name,!
Title&of&Book:&Subtitle&of&Book&!(Place!of!Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

2.!Norman!Geisler!and!Ron!Rhodes,!Conviction&Without&Compromise:&Standing&Strong&in&the&Core&

Beliefs&of&the&Christian&Faith!(Eugene,!Oregon:!Harvest!House!Publishers,!2008),!45K46.!
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!

4.4!

Long Note – 3 or More Authors 

!

N:!!Note!Number.!!1st!Author!First!Name!and!Last!Name,!2nd!Author!First!and!Last!Name,!and!3rd!
Author!First!and!Last!Name,!Title&of&Book:&Subtitle&of&Book!(Place!of!Publication:!Publisher’s!Name,!Date!
of!Publication),!XXKXX.!

3.!William!Lane!Craig,!James!P.!Moreland,!and!Francis!Beckwith,!To&Everyone&an&Answer:&A&Case&for&
the&Christian&Worldview!(Downers!Grove,!Illinois:!Intervarsity!Press,!1998),!10K11.!!

!

N:!!Note!Number.!!1st!Author!First!Name!and!Last!Name,!2nd!Author!First!and!Last!Name,!3rd!Author!
First!and!Last!Name,!and!4th!Author!First!and!Last!Name,!Title&of&Book:&Subtitle&of&Book!(Place!of!
Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

4.!John!Hick,!Clark!H.!Pinnock,!Alister!E.!McGrath,!and!R.!Douglas!Geivett,!Four&Views&on&Salvation&in&
a&Pluralistic&World!(Grand!Rapids,!Michigan:!Zondervan!Publishing!House,!1995),!95K96.!

!

4.5!

Long Note - Editor or Author(s) plus Editor 

!

Editor!Only:!

N:!!Note!Number.!!Editor’s!First!and!Last!Name,!ed.,!!Title&of&Book:&Subtitle&of&Book.!(Place!of!
Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

5.!!Ronald!F.!Youngblood,!ed.,!Nelson's&New&Illustrated&Bible&Dictionary:&Completely&Revised&And&

Updated&Edition.&(Nashville,!Tennessee:!Thomas!Nelson,!1990),!33K34.!!

Author!plus!Editor:!

N:!!Note!Number.!!Author’s!First!and!Last!Names,!Title&of&Book:&Subtitle&of&Book,!ed.!Editor’s!First!
and!Last!Names!(Place!of!Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

6.!Lewis!Sperry!Chafer,!Systematic&Theology&Abridged,!ed.&John!F.!Walvoord!!(Wheaton,!Illinois:!
Victor!Books,!1974),!76.!
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!

4.6!

Long Note – Edition Number 

!

N:!!Note!Number.!Author’s!First!and!Last!Name,!Title&of&Book:&Subtitle&of&Book,!Edition!Number!ed.!!
(Place!of!Publication:!Publisher’s!Name,!Date!of!Publication),!XXKXX.!

7.!Warren!W.!Wiersbe,!Be&Joyful:&A&Practical&Study&of&Philippians,!15th!ed.!(Wheaton,!Illinois:!Victor!
Books,!1974),!56K57.!

!

4.7!

Long Note - Journal Article in Print 

!

Reminder:!the!title!of!the!article!is!set!in!quotes,!the!title!of!the!journal!is!italicized.!

N:!Note!Number.!!Author’s!First!and!Last!Name,!“Title!of!Article:!Subtitle!of!Article,”!Title&of&Journal!
Volume!Number!(Date!of!Publication):!XXKXX.!

8.!Norman!L.!Geisler,!“Jesus!and!Muhammed!in!the!Qur’an:!A!Comparison!and!Contrast,”!Southern&
Baptist&Journal&of&Theology!8,!no.!1!(Spring!2004):!50.!

4.8!

Long Note - Journal Article Online 

!

N:!Note!Number.!!Author’s!First!Name!and!Last!Names,!!“Title!of!Article:!Subtitle!of!Article,”!Title&of&
Journal!Volume!Number!(Date!of!Publication),!under!“Descriptive!Locator,”!URL!(accessed!Date!of!
Access).!

9.!Andrew!Bernhard,!“Dating!Early!Christian!Gospels,”!Journal&of&Biblical&Studies&1,!no.!4!(OctKDec!
2001),!under!“Articles,”!http://journalofbiblicalstudies.org/Issue4/Articles/dating_early_!
christian_gospels.htm!!(accessed!September!20,!2010).!

!

!
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4.9!

Long Note – Web Sites 

Even!though!many!online!webKsites!lack!relevant!information!for!a!proper!citation,!try!to!include!as!
much!pertinent!information!as!possible.!

N:!Note!Number.!Author’s!First!and!Last!Name,!“Title!of!the!Web!Page,”!Title!or!Owner!of!the!Site,!
URL!(accessed!Date).!

10.!Charlie!Campbell,!“Twenty!Reasons!Christians!Believe!Jesus!is!God,”!The!Always!Be!Ready!
Apologetics!Ministry,!!http://www.alwaysbeready.com/!index.php?option=!com_content&!
task=view&id=94&Itemid=0!(accessed!September!20,!2010).!

!

4.10!

Long Note - Lectures 

N:!Note!Number.!Speaker’s!First!and!Last!Name,!“Title!of!Lecture,”!(Sponsorship,!Place!and!Location!
of!Lecture,!Date!of!Lecture).!!

11.!Chuck!Smith,!“A!Venture!in!Faith,”!(Friday!Lectures,!Calvary!Chapel!Bible!College,!Murrieta,!CA,!
September!03,!2010).!

!

!

5.0!

The Short Footnote 

The!first!time!you!use!a!footnote!for!a!particular!source!make!it!long.!!If!the!same!source!is!used!again,!
then!make!it!shorter.!!Include!the!author’s!last!name!and!at!least!one!to!four!distinctive!words!from!the!
title,!and!page!numbers.!!

!

5.1!

Short Note - Single Author 

!
N:!Note!Number.!Author’s!Last!Name,!Shortened&Title,!XXKXX!
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!
Example!!

!
Here!is!the!Quote:!
!

Q:!!!In!presenting!his!case!for!Christianity,!Lee!Strobel!urges!his!readers!to!
“thoughtfully!consider!the!credibility!of!the!witnesses,!carefully!sift!the!
testimony,!and!rigorously!subject!the!evidence!to!common!sense!and!logic.”1!

Long!footnote!9!the!first!time!it!is!cited.!
!

N:!!!1.!!Lee!Strobel,!!The&Case&For&Christ:&A&Journalist’s&Personal&Investigation&of&
the&Evidence&for&Jesus![Grand!Rapids:!Zondervan,!1998],!18.!

Short!footnote!9!when!the!source!is!cited!again.!
!

N:!!!2.!Strobel,!Case&For&Christ,!92K93.!
!

5.2!

Short Note -Two Authors 

N:!Note!Number.!1st!Author’s!Last!Name!and!2nd!Author’s!Last!Name,!Shortened&Title,!XXKXX.!

Example!!

Here!is!the!Quote:!

Q:!!!Geisler!and!Rhodes’!philosophy!on!Christian!doctrine!can!be!distilled!into!
one!essential!dictum,!“In!essentials,!unity;!in!nonessentials,!liberty;!and!in!all!
things,!charity.”5!

Long!footnote!9!the!first!time!it!is!cited.!
!

N:!!!5.!Norman!Geisler!and!Ron!Rhodes,!Conviction&without&Compromise:&

Standing&Strong&in&the&Core&Beliefs&of&the&Christian&Faith,![Eugene:!Harvest!
House!Publishers,!2008],!16.!

Short!footnote!–!when!it!is!cited!again.!

N:!!!6.!Geisler!and!Rhodes,!Conviction,!121K123.!

!

!

!
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5.3!

Short Note - Three Authors 

N:!!Note!Number.!!1st!Author!Last!Name,!2nd!Author!Last!Name,!and!3rd!Author!Last!Name,!Shortened&
Title,!XXKXX.!

Example!!

! Long!footnote9the!first!time!it!is!cited!

!!!!!!9.!Jack!Bartlett!Rogers,!Ross!Mackenzie,!and!Louis!Weeks,!!Case&Studies&in&
Christ&and&Salvation!(Philadelphia,!Pennsylvania:!!Westminster!Press,!1977),!25K
26.!

Short!footnote!–!when!it!is!cited!again!

!!!!!10.!Rogers,!Mackenzie,!and!Weeks,!Case&Studies,!28.!

!

5.4!

Short Note – Four or More Authors 

! Example!

Long!note!–!the!first!time!it!is!cited!

11.!!John!Hick,!Clark!H.!Pinnock,!Alister!E.!McGrath,!and!R.!Douglas!Geivett,!Four&
Views&on&Salvation&in&a&Pluralistic&World!(Grand!Rapids,!Michigan:!Zondervan!
Publishing!House,!1995),!95K96.!

Short!footnote!–!when!it!is!cited!again!

12.!!Hick!et!al.,!Four&Views,!102.!

!

5.5!

Short Note - Journal Article in Print 

N:!Note!Number.!!Author’s!Last!Name,!“Shortened!Title!of!Article,”!XXKXX.!

Example!!
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Long!Note!

13.!Norman!L.!Geisler,!“Jesus!and!Muhammed!in!the!Qur’an:!A!Comparison!and!
Contrast,”!Southern&Baptist&Journal&of&Theology!8,!no.!1!(Spring!2004):!50.!

Short!Note!

14.!Geisler,!“Jesus!and!Muhammed,”!55.!

5.6!

Parenthetical Notes: Many References to a Few Sources 

If!you!plan!on!referring!frequently!to!numerous!passages!from!only!a!few!sources!(3!or!less),!then!it!is!
cleaner!and!more!readable!to!use!parenthetical!notes!after!the!first!footnote.!!The!parenthetical!note!
substitutes!for!the!footnote!and!is!placed!where!the!superscript!number!would!be.!!The!difference,!
however,!is!the!parenthetical!note!is!in!its!shortened!form!and!is!placed!within!parenthesis!and!before!
the!end!punctuation.!!There!are!three!types!listed!below.!

!

Page!number!only:!

If!you!mention!the!author!and!title!in!your!writing,!and!if!readers!can!easily!identify!the!specific!
source,!then!you!may!only!include!the!page!number!in!the!parenthesis.!

Example!

After!examining!the!corroborating!evidence!for!Jesus,!Strobel!now!focuses!his!
journalistic!eyes!upon!the!scientific!evidence!in!the!Case&for&Christ!(122).!

Author!and!page!number:!

If!readers!cannot!identify!the!author,!and!if!you!have!already!once!cited!the!author,!then!include!
the!author’s!last!name!and!page!number!in!the!parenthesis.!

Example!

As!noted,!the!overwhelming!archeological!evidence!remarkably!affirms!the!New!
Testament’s!historical!accuracy!(Strobel,!143).!

Title!and!page!number:!

If!you!have!cited!more!than!one!work!by!the!same!author,!and!if!readers!can!easily!identify!the!
author,!then!only!include!the!shortened!title!and!page!number!in!the!parenthesis.!

!
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Example!

After!examining!the!evidence!for!the!case!for!Christ,!Strobel!moves!on!to!an!
examination!of!objections!to!the!Christian!faith!(The&Case&for&Faith,!5)!

5.7!

Ibid. 

The!Latin!term!ibid!is!derived!from!the!Latin!word!ibidem!or!“in!the!same!place.”!!If!you!cite!a!work!
repeatedly!and!concurrently,!use!ibid.!to!refer!to!a!work!immediately!cited!in!the!previous!note.!

21.!Geisler,!“Jesus!and!Muhammed,”!81.!
22.!Ibid.,!95.!
23.!Ibid.,!98.!

!

6.0!

Citing the Bible in a Footnote & Parenthetical Note 

Citing!the!Bible!is!unique!and!involves!two!things:!a!footnote!with!full!bibliographical!data!for!the!first!
footnote!citation!and!then!parenthetical!notes!afterwards.!Parenthetical!notes!will!be!discussed!later!
(see!6.6).!!As!an!exception,!you!do!not!need!to!include!an!entry!for!the!Bible!in!the!Bibliography.!!
However,!for!all!other!sources,!you!do.!!The!first!time!you!note!the!Bible,!use!its!full!traditional!name!in!
a!long!note;!afterwards,!use!its!abbreviation.!!If!you!switch!versions!or!translations,!you!must!include!full!
bibliographic!data!for!that!version!in!a!long!note!and!then!afterwards!use!its!abbreviation!in!short!notes.!!
Here!is!a!list!of!abbreviations!for!a!number!of!translations!and!versions:!!

6.1!

Bible Abbreviations 

 
Well!Known!Formal!Equivalent!Translations!
!
! Full!Traditional!Name!! ! ! Abbreviation!

English!Standard!Version! ! ! ESV!
Authorized!King!James!Version! ! KJV!or!AV!
New!American!Standard!Bible! ! NASB!
New!King!James!Version! ! ! NKJV!

!
Other!Formal!and!Dynamic!Equivalent!Versions!
!
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Amplified!Bible! ! ! ! AB!
American!Revised!Version! ! ! ARV!
American!Standard!Version! ! ! ASV!
Contemporary!English!Version! ! CEV!
Douay!Version!! ! ! ! DV!
English!Revised!Version! ! ! ERV!
Good!News!Translation! ! ! GNT!
Holman!Christian!Standard!Bible! ! HCSB!
Jerusalem!Bible! ! ! ! JB!
The!Living!Bible! ! ! ! LB!
New!American!Bible! ! ! ! NAB!
New!English!Bible! ! ! ! NEB!
New!Living!Translation! ! ! NLT!!
New!International!Version! ! ! NIV!
NIV!Study!Bible! ! ! ! NIVSB!
New!Revised!Standard!Version! ! NRSV!!
Revised!Standard!Version! ! ! RSV!
Todays!New!International!Version! ! TNIV!
Vulgate! ! ! ! ! Vulg.!
Wuest!Expanded!Translation! ! ! Wuest!
!

6.2!
!

How to use Bible Abbreviations 

Different!versions!and!translations!of!the!Bible!usually!contain!variations!in!language,!so!the!version!or!
translation!must!be!identified!either!by!its!full!name!or!by!its!abbreviation.!!You!do!not!need!to!repeat!
the!abbreviation!if!all!the!notes!are!from!the!same!version!or!translation.!!If!you!switch!versions!or!
translation,!however,!indicate!the!change!by!its!abbreviation.!Any!note!following!that!abbreviation!will!
be!from!that!version!or!translation!until!another!change!occurs.!!Never!include!a!page!number.!Books!of!
the!Bible!should!be!abbreviated!in!footnotes!and!in!parenthetical!citations.!!
!

Examples!
!

N:! 2.!!Isa.!7:14!(English!Standard!Version).!
! 3.!!Matt.!1:18K23.!
! 4.!!Ps.!34:20!(NASB).!
! 5.!!John!19:31K36!(ESV)!!!
!
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!

6.3!

Old Testament Books 
Full!Name! Abbreviation!
Genesis! Gen.!
Exodus! Exod.!
Leviticus! Lev.!
Numbers! Num.!

Deuteronomy! Deut.!
Joshua! Josh.!
Judges! Judg.!
Ruth! Ruth!

1!Samuel! 1!Sam.!
2!Samuel! 2!Sam.!
1!Kings! 1!Kings!
2!Kings! 2!Kings!

1!Chronicles! 1!Chron.!
2!Chronicles! 2!Chron.!

Ezra! Ezra!
Nehemiah! Neh.!
Esther! Est.!
Job! Job!

Psalm(s)! Ps.!(Pss.)!
Proverbs! Prov.!

Ecclesiastes! Eccl.!
Song!of!Solomon! Song!of!Sol.!

Isaiah! Isa.!
Jeremiah! Jer.!

Lamentations! Lam.!
Ezekiel! Ezek.!
Daniel! Dan.!
Hosea! Hos.!
Joel! Joel!
Amos! Amos!

Obadiah! Obad.!
Jonah! Jon.!
Micah! Mic.!
Nahum! Nah.!

Habakkuk! Hab.!
Zephaniah! Zeph.!
Haggai! Hag.!

Zechariah! Zech.!
Malachi! Mal.!

6.4!!

New Testament Books 

Full!Name! Abbreviation!
Matthew! Matt.!
Mark! Mark!
Luke! Luke!
John! John!
Acts! Acts!

Romans! Rom.!
1!Corinthians! 1!Cor.!
2!Corinthians! 2!Cor.!
Galatians! Gal.!
Ephesians! Eph.!
Philippians! Phil.!
Colossians! Col.!

1!Thessalonians! 1!Thess.!
2!Thessalonians! 2!Thess.!

1!Timothy! 1!Tim.!
2!Timothy! 2!Tim.!

Titus! Titus!
Philemon! Philem.!
Hebrews! Heb.!
James! James!
1!Peter! 1!Pet.!
2!Peter! 2!Pet.!
1!John! 1!John!
2!John! 2!John!
3!John! 3!John!
Jude! Jude!

Revelation! Rev.!
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!

6.5!

!

When!citing!three!or!more!verses!in!a!row!from!the!same!chapter!and!book,!you!need!only!use!the!first!

and!last!verse!number!separated!by!a!dash.!!The!same!can!be!applied!to!parenthetical!notes.!

! ! N:! 9.!!1!Pet.!1:13H15!

! ! ! 10.!!James!3:1H3!

6.6!

Parenthetical Notes for the Bible 

If!you!plan!on!referring!frequently!to!numerous!passages!from!the!Bible,!then!it!is!cleaner!and!more!

readable!to!use!parenthetical!notes!after!the!first!long!footnote.!!The!parenthetical!note!substitutes!for!

the!footnote!and!is!placed!where!the!superscript!number!would!be.!!It!is!identical!in!structure!as!the!

footnote.!!The!difference!is,!however,!the!parenthetical!note!is!always!shortened!and!is!always!placed!

within!parenthesis!and!placed!before!the!end!punctuation!mark!of!the!sentence,!usually!a!period.!!Here!

is!an!example,!with!several!parenthetical!references!to!the!Bible.!

Example!

Both!Peter!and!Paul!unashamedly!defend!the!divine!authority!of!Scripture.!!Peter!declares!that!

“no!prophecy!of!Scripture!came!about!by!the!prophet’s!own!interpretation.!!For!prophecy!never!

had!its!origin!in!the!will!of!man,!but!men!spoke!from!God!as!they!were!carried!along!by!the!Holy!

Spirit”!(2!Pet.!1:20H21).!!Looking!back!on!the!whole!Old!Testament,!the!apostle!Paul!wrote,!“All!

Scripture!is!GodHbreathed!and!is!useful!for!teaching,!rebuking,!correcting,!and!training!in!

righteousness,!so!that!the!man!of!God!may!be!thoroughly!equipped!for!every!good!work”!(2!

Tim.!3:16H17).!

7.0!

The Bibliography 

In!addition!to!being!quoted!inHtext!and!given!a!footnote,!most!sources!must!be!listed!in!a!bibliography!at!

the!end!of!the!paper!on!a!separate!page!with!the!second!line!indented.!!Some!types!of!sources,!

however,!are!omitted:!do!not!include!these!sources!in!the!Bibliography:!

• Newspaper!articles!

• The!Bible!and!other!sacred!works!

• WellHknown!dictionaries!and!encyclopedias!

• Email!
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• Unpublished!interviews!
• Pamphlets!
• Artwork,!live!performances,!television!broadcasts!

!
For!all!other!sources,!do!include!them!in!the!Bibliography.!!A!bibliographic!entry!will!have!much!of!the!
same!information!found!in!a!long!note!with!some!slight!differences.!!Like!the!patterns!for!a!note,!the!
patterns!on!how!to!create!a!bibliographic!entry!are!precise!and!must!be!followed!exactly.!!Minute!
details!for!order,!punctuation,!capitalization,!italics,!indentation,!to!mention!a!few!details,!must!be!
observed.!!Also,!the!list!must!be!alphabetized!by!last!name.!!

7.1!

Bibliography - Single Author 

B:!Author’s!Last!Name,!Author’s!First!Name.!!Title&of&Book:&Subtitle&of&Book.!Place!of!Publication:!
Publisher’s!Name,!Date!of!Publication.!

Example:!

Lightfoot,!Niel!R.!!How&We&Got&The&Bible.!Grand!Rapids,!Michigan:!Baker!Books,!2006.!

!

7.2!

Bibliography - Two Authors 

B:!1st!Author!Last!Name,!1st!Author!First!Name,!and!2nd!Author!First!Name!2nd!Author!Last!Name.!Title&of&
Book:&Subtitle&of&Book.!Place!of!Publication:!Publisher’s!Name,!Date!of!Publication.!

Example:!

Feinberg,!!John!S.,!and!Paul!D.!Feinberg.!Ethics&for&a&Brave&New&World.&&Wheaton,!Illinois:!
Crossway!Books,!1993.!

7.3!

Bibliography - Three Authors 

B:!1st!Author!Last!Name,!1st!Author!First!Name,!and!2nd!Author!First!Name!2nd!,!and!3rd!Author!First!Name!
3rd!Author!Last!Name.!Title&of&Book:&Subtitle&of&Book.!Place!of!Publication:!Publisher’s!Name,!Date!
of!Publication.!

Example:!

Craig,!William!Lane,!and!James!P.!Moreland,!and!Francis!Beckwith.!!To&Everyone&an&Answer:&A&
Case&for&the&Christian&Worldview.!!Downers!Grove,!Illinois:!Intervarsity!Press,!2004.!
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!

!

7.4!

Bibliography - Four Authors 

B:!1st!Author!Last!Name,!1st!Author!First!Name,!and!2nd!Author!First!Name!2nd!Last!Name,!and!3rd!Author!

First!Name!3rd!Author!Last!Name,!and!4th!Author!First!Name!4th!Author!Last!Name.!Title&of&Book:&
Subtitle&of&Book.!Place!of!Publication:!Publisher’s!Name,!Date!of!Publication.!

Example:!

Geisler,!Norman!L.,!and!Michael!Scott!Horton,!and!Stephen!M.!Ashby,!and!Matthew!J.!Pinson.!

Four&Views&on&Eternal&Security.!Grand!Rapids,!Michigan:!Zondervan!Publishing!House,!2002.!

!

7.5!

Bibliography -Editor or Author(s) plus Editor 

Editor'Only'

B:!Editor’s!Last!Name,!Editor’s!First!Name,!ed.!!Title&of&Book:&Subtitle&of&Book.!Place!of!Publication:!
Publisher’s!Name,!Date!of!Publication.!

Example:!

Youngblood,!Ronald!F.,!ed.!!Nelson's&New&Illustrated&Bible&Dictionary:&Completely&Revised&And&
Updated&Edition.&Nashville,!Tennessee:!Thomas!Nelson,!1995.!!

'

Author'plus'Editor:'

B:!Author’s!Last!Name,!Author’s!First!Name.!!Title&of&Book:&Subtitle&of&Book.!Edited!by!Editor’s!First!and!
Last!Names.!!Place!of!Publication:!Publisher’s!Name,!Date!of!Publication.!

Example:!

Chafer,!Lewis!Sperry.!Systematic&Theology&Abridged.!Edited!by!John!F.!Walvoord.!!Wheaton,!

Illinois:!Victor!Books,!1988.!

!

!



!!!!!!!!!!!!CCBC!Style!Guide!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!26!

!

!

7.6!

Bibliography - Edition Number 

B:!Author’s!Last!Name,!Author’s!First!Name.!!Title&of&Book:&Subtitle&of&Book.!Edition!Number!ed.!!Place!of!

Publication:!Publisher’s!Name,!Date!of!Publication.!

Example:!

Pentacost,!J.!Dwight.!Design&for&Discipleship.!!14th!ed.!Grand!Rapids,!Michigan:!Zondervan!

Publishing!House,!1980.!

!

7.7!

Bibliography - Journal Article in Print 

B:!Author’s!Last!Name,!Author’s!First!Name.!!“Title!of!Article:!Subtitle!of!Article.”!Title&of&Journal!Volume!

Number!(Date!of!Publication):!YYbYY.!

Example:!

Charles,!J.!Daryl.!!“Returning!to!Moral!‘First!Things’:!The!NaturalbLaw!Tradition!and!Its!

Contemporary!Application,”!Philosophia&Christi!6,!no.!1!(2004):!59b76.!

!

7.8!

Bibliography - Journal Article Online 

B:!Author’s!Last!Name,!Author’s!First!Name.!“Title!of!Article:!Subtitle!of!Article.”!Title&of&Journal!Volume!

Number!(Date!of!Publication).!URL!(accessed!Date).!

Example:!

Bernhard,!Andrew.!“Dating!Early!Christian!Gospels.”!Journal&of&Biblical&Studies&1,!no.!4!(OctbDec!
2001).!!http://journalofbiblicalstudies.org/Issue4/Articles/dating_early_!christian_!

gospels.htm!!(accessed!September!20,!2010).!

7.9!

Bibliography - WebSite 
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B:!Author’s!Last!Name,!Author’s!First!Name.!!“Title!of!the!Web!Page.”!Title!or!Owner!of!the!Site.!URL!

(accessed!Date).!

Example:!

Campbell,!Charlie.!!“Twenty!Reasons!Christians!Believe!Jesus!is!God.”!!The!Always!Be!Ready!

Apologetics!Ministry.!http://www.alwaysbeready.com/!index.php?option=!

com_content&task=view&id=94&Itemid=0!(accessed!September!20,!2010).!

7.10!

Bibliography - Lectures 

B:!Speaker’s!Last!Name,!First!Name.!!“Title!of!Lecture.”!!Name!of!Event.!!Sponsor,!Location!of!Lecture,!

Date!of!Lecture.!

Example:!

Smith,!Chuck.!“A!Venture!in!Faith.”!Friday!Lectures.!Calvary!Chapel!Bible!College,!Murrieta,!

California,!September!03,!2010.!!!

7.11!

Bibliography - The Bible 

No!bibliographic!entry!should!be!included!for!the!Bible!or!other!sacred!texts.!!Please!see!sections!3.3,!

3.4,!and!6.0b6.7!on!how!to!cite!the!Bible.!
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!
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Bibliography!Example:!

!

!

8.0!

Helpful Links 
For!Citation! 

http://citationmachine.net/!

http://bcs.bedfordstmartins.com/resdoc5e/!

http://www.easybib.com/!

http://www.bartleby.com/141/!

http://www.noodletools.com/!

http://www.chicagomanualofstyle.org/home.html!

http://owl.english.purdue.edu/owl/!


